Nutrient management (NM) planning is one of the best practices farmers can use to reduce excess nutrient applications to their cropland and the water quality problems that result from nutrient runoff to lakes, streams and groundwater. The Wisconsin Department of Agriculture, Trade and Consumer Protection (DATCP) tracks farms that develop and update their 590 NM plans when NM Plan Checklist forms are submitted to DATCP by farmers, agronomists, and public agency staff. In 2015, Wisconsin farmers made impressive strides toward implementing soil and water conservation through the development of 6,708 NM plans on 2,875,779 acres, an 11% acre increase from 2014, covering 31% of Wisconsin’s 9 million cropland acres.

A NM plan is a crop practice record that is annually reviewed, and when necessary, updated. Knowing where nutrients are needed and where they are not helps farmers allocate nutrients economically while also helping to ensure they are not over-applying nutrients, which could cause water quality impacts.

A NM plan follows Natural Resources Conservation Service’s WI 590 Nutrient Management Standard and is prepared by a qualified planner, which may be the farmer or a certified crop adviser. A NM plan accounts for all N-P-K nutrients applied, and planned to be applied, to fields over the crop rotation.

Who Wrote 2015’s Nutrient Management Plans?

1,591 farmers wrote their own plans on 434,661 acres, 75 thousand more acres than 2014, a 21% increase in acres. In 2015, farmer-written plans accounted for 24% of all NMPs on 5% of Wisconsin’s cropland acres.

5,117 farmers hired 408 agronomists to assist them with NM planning on 2,441,118 acres, 216 thousand more acres than last year, a 10% increase from 2014. In 2015, agronomists produced 76% of all NMPs on 27% of Wisconsin’s cropland acres.

Nutrient Management Reported by County

63 of 72 WI Counties Reported NM Plans in 2015

Most Acreage with NMPs

<table>
<thead>
<tr>
<th>County</th>
<th>Acreage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brown</td>
<td>177K</td>
</tr>
<tr>
<td>Dane</td>
<td>130K</td>
</tr>
<tr>
<td>Manitowoc</td>
<td>122K</td>
</tr>
<tr>
<td>Fond du Lac</td>
<td>173K</td>
</tr>
<tr>
<td>Dodge</td>
<td>123K</td>
</tr>
<tr>
<td>Kewaunee</td>
<td>114K</td>
</tr>
<tr>
<td>Marathon</td>
<td>171K</td>
</tr>
<tr>
<td>Outagamie</td>
<td>123K</td>
</tr>
<tr>
<td>Rock</td>
<td>87K</td>
</tr>
<tr>
<td>Jefferson</td>
<td>151K</td>
</tr>
<tr>
<td>Clark</td>
<td>123K</td>
</tr>
<tr>
<td>Calumet</td>
<td>80K</td>
</tr>
</tbody>
</table>

When Can a NM Plan Be Required?

Farms can be required to implement nutrient management with a $28/ac cost share offer or if:

1. Causing a significant discharge.
2. Regulated by local manure storage or livestock siting ordinances, or by a DNR WPDES permit,
3. Accepting NM planning or manure storage cost share funds, or
4. Participating in the Farmland Preservation Program.

Farmland Preservation Tax Credits Have Increased NM Acres

County conservation departments are working hard with Farmland Preservation program (FP) claimants so they can continue to claim the Farmland Preservation tax credit. A high priority is to get NM plans in place and assure the farm does not have runoff issues so the county can issue the owners a Certificate of Compliance.
Since 1995, the agency staff and private sector agronomists of the Quality Assurance Team (QAT) have conducted reviews of NM plans with the goal of improving implementation and protection of our soil and water resources. In 2015, the QAT team (listed below) reviewed 65 plans covering 40,503 acres.

This year a revised NM plan review form was used in order to develop a clearer picture of where our NM program needs the most attention. The new form has more reporting categories. Therefore, results from past reviews (pre-2014) are not perfectly comparable to those using this form where NM planners have consistently performed well.

Try it! Review your own plan, the NMP Review form is available here:
http://datcp.wi.gov/Farms/Nutrient_Management/

Since 2009, on average the best categories have been the identification of N soils and Surface Water Quality Management Areas (SWQMAs). Wisconsin planners are good, and getting better, at making complete maps and using that information in SnapPlus. The most common mistakes that planners make have been describing the state of concentrated flow channels and making sure soil samples are being taken at 5 acres per sample every 4 years (see Fig. 2, next page). Reviewers look for information on concentrated flow channels in the narrative, on the maps and/or in season notes – keeping this information updated in any one of these spots will help the reviewer know that the field is not exceeding T and meet the requirement that these are staying protected or being repaired if necessary.

Did you know? Labels for soil sampling bags can be created and printed from SnapPlus to ensure the correct number of samples are taken? The video showing how to do this is available on the YouTube page:
http://youtube.com/snapplusUW

Planners are doing a consistently better job planning for restricted features and times, especially working with N-restricted soils. Restrictions are being mapped correctly, so now we need to focus on linking those to the fields in SnapPlus. SnapMaps will help out with making that connection to the plans, so we anticipate a significant increase in this aspect of NM planning once SnapMaps is adopted by more planners.

The most consistent mapping deficiency is the identification of wells and other direct conduits to groundwater on the maps. Even with SnapMaps these field-level, site-specific features will still need to be added manually to the maps in order for those restrictions to come through to the database. When using SnapMaps, drinking wells added to the maps will automatically receive the 50 and 200 foot buffer with the click of a button, so be sure to get all those wells marked!

Figure 1. Since 2009 the percentage of NM plans that correctly handled all applications near sensitive features or during restricted times (e.g., nitrogen-restricted soils in the fall, winter applications of manure) has steadily increased. SnapMaps can now automatically link many of these map attributes to the SnapPlus database, making planning applications around these features easier.

Maps and Restrictions

2015 QAT Members:
Wayne Kayhart, Marshfield Ag Service; Kelsie Faber, Liegel Consulting; Morgan Link, Marquette County; Scott Fleming, Rock River Laboratory; Josh Saykally, Waushara County; Amy Mansfield, DeLong Company; John Easker, Jay-Mar Crop Consultant; Laura Ward Good, UW Madison; Taylor Schuetz, Insight FS; Ann Hoffman, Jay-Mar Crop Consultant; Jim Beaudoin, UW Madison; Jeff Landon, Crop Consultant; Abby Rotering, Dairyland Lab; Rick Wayne, UW Madison; Brent Tessmer, Clark County; Leah Nicol, Dunn County; Joe Wolter, UW Madison; Melissa Keenan, Sauk County; Bobbi Holl, Crop Consultant; Stephanie Schneider, DATCP; Brian Sadler, Sauk County; Terence Kelly, NRCS; Mark Jenks, DATCP; Joe Baeten, DNR; Sue Porter, DATCP
Keep in mind that DATCP certified labs need to be used (only one plan in the review used a non-DATCP lab this year) to process soil tests.

**DATCP Certified Labs:**
- A & L Great Lakes Laboratories (Fort Wayne, IN)
- AgSource Soil & Forage Lab (Bonduel, WI)
- Dairyland Laboratories (Arcadia, WI)
- Rock River Laboratory (Watertown, WI)
- UW Soil & Forage Lab (Marshfield, WI)


For the purposes of managing phosphorus (P) and soil erosion it is important to plan or historically track a field during its entire rotation. Some of the newer tools in SnapPlus can make future planning and updates for long rotations easier and faster. With the arrival of SnapMaps we anticipate significant increases in some planning categories, such as choosing the correct dominant critical soil and making sure each field in the SnapPlus database is also shown on the maps or vice versa (Fig. 4).
What’s New in SnapPlus 15.0

SnapPlus 15.0 Beta was released in October 2015 and includes many updates to soils, crop & tillage options, and fertilizer blend tools. Two noteworthy new tools include the new Cropping Grid and inclusion of SnapMaps! For more information about all of the new features, when in SnapPlus 15.0 see "What’s New in 15.0” in the Help Menu.

Cropping Grid

View all fields in the cropping screen by year instead of viewing all years one field at a time. To change the view: click on Cropping Grid Edit in the View menu. You can still click on cells to manage the data (“Over/Under N-P2O5-K2O” opens the Nutrient Application Planner screen). Click on headers to sort by that column.

SnapMaps is Here!

What is it?
SnapMaps is the integration of an interactive map with the SnapPlus software program. This allows the program to automatically identify and import field information from the maps. SnapMaps is divided into two sections. One is the website where you draw new fields or import your existing field boundaries, the other is the SnapMaps tab in the Field screen of SnapPlus where the data is stored. To begin using SnapMaps, download SnapPlus 15.0 and start at the new SnapMaps Tab in the Field screen (see below for instructions). Importantly, you can still use SnapPlus 15.0 and all of its many enhancements and improvements without using SnapMaps – it is not required!

Why is SnapMaps so great?

- **Direct Connection Between Maps and the Plan** – Now the maps are connected directly with SnapPlus meaning much of the spatial field information can be automatically brought into your SnapPlus database (e.g., dominant critical soil and any existing landscape restrictions will automatically be chosen for you). You can upload your existing shapefiles, or create new ones within SnapMaps.

  - **Much Faster** - The time needed to complete the Field tab in SnapPlus may go from hours to minutes.

  - **Less User Error** - By bringing information from the soil and restriction maps directly into your SnapPlus database, errors and omissions will become rare (e.g. fields within the SWQMA will automatically be noted).

  - **Better Information** – As soils and hydrologic layers are updated, SnapMaps incorporates those updates each year to make sure planning is as accurate as possible.

  - **Easier Data Management** – With the maps now inside the database, data management and sharing is easier – it’s all in one place!

Starting Out in SnapMaps

**IMPORTANT - Internet access is required.**

1. On the Fields page in SnapPlus, go to the new SnapMaps tab and click 1. Upload to send the database information to the mapping website.

2. Click 2. Website* to open the website where you can create your soil and restriction maps

3. Draw or import shapefiles** of the field boundaries, add wells, etc.

4. Click 3. Download to bring the spatial information from the website/maps into the database.

5. Select the information on the SnapMap Fields tab and SnapMap Restrictions tab that you would like to use in the database and click Import to SnapPlus to populate or overwrite the data in the Fields page. Note that Field page data in the database can always be changed even after overwriting.

---

http://snapplus.wisc.edu/downloads/
Tools and features inside of SnapMaps that are independent of the SnapPlus database will be updated in real-time; updates are not dependent on a new version of SnapPlus to be released and downloaded. This means things like the map output (Fig. 5) can be revised at any time. Try using SnapMaps today and send in your suggestions!

Figure 5. An example restriction map PDF output from SnapMaps with field boundaries, field names, and wells identified.

SnapPlus and SnapMaps Support

Help Menu

The Help Menu in SnapPlus includes a ton of information on all aspects of the program and its use. Please check here to get many of your questions answered! Tip: Whatever page you are on inside of SnapPlus when you click the Help button, the content for that page will automatically open up. If that doesn’t work, please contact us to attend one of the many trainings we offer year-round. See below for more information about our trainings and how to contact our team!

DATCP offers a variety of in-person trainings:

- Basic SnapPlus
- Advanced SnapPlus
- How to review a NM plan
- One-on-one
- Assistance with farmer trainings
- New conservation staff training
- Others available upon request

Check the SnapPlus website for scheduled trainings or contact the DATCP NM staff to offer one in your area!

http://snapplus.wisc.edu/news-help/training-opportunities

For More Nutrient Management Information and Forms:

Or, watch step-by-step videos on SnapMaps and many other features of the program, whenever and wherever it’s most convenient for you:

www.YouTube.com/SnapPlusUW

Technical SnapPlus support: support@snapplus.wisc.edu

DATCP NM Specialists

- Sue Porter, 608-224-4605, Sue.Porter@wi.gov
- Stephanie Schneider, 715-832-6547 x113, Stephanie.Schneider@wi.gov
- Mark Jenkins, 608-224-4507, Mark.Jenkins@wi.gov
- Rachel Rushmann, 608-224-4622, Rachel.Rushmann@wi.gov
Beginning a New Era of Soil Conservation and Nutrient Management Planning

Over the past 10 years the SnapPlus development team in the University of Wisconsin’s Soil Science Department have continually improved Wisconsin’s software tools for nutrient management planning. This release of SnapPlus15.0 with SnapMaps is a giant step forward in the software. This version links directly with soil survey and 590 restriction maps over the internet. Farmers and agronomists will now be able to develop and update plans faster because this software automatically fills in each field’s soils and nutrient spreading restrictions. This will also take the guess work out of choosing the dominant critical soil that has the highest Erosion Sensitivity and covers at least 10% of the field. The software allows planners to enter and maintain different soil or restriction information for a field where field observation indicates that the map’s designations are not appropriate. No longer will separate maps need to be submitted with each plan, because the map will be in the database and viewable through the internet.

Changes to the NRCS Soil Survey Will Affect Nutrient Management Planning

The Natural Resources Conservation Service (NRCS) continually works to update their soil survey maps and the database of soil properties for each soil map unit. They release annual updates for the soil survey information and these updates are incorporated into UW-Extensions Soil Group and Yield Potential designations for nutrient recommendations, the 590 Restriction Maps, and soil properties databases in SnapPlus. Currently NRCS is in the middle of a multi-year process to make soil map unit characteristics consistent across county boundaries. In this process, the characterizations of properties that affect soil yield potential, such as available water capacity, have been refined for some map units. In addition, the NRCS has recalculated two of the factors related to sheet and rill erosion calculations, soil Erodibility (K) and Tolerable soil loss (T), so that these factors are now determined using consistent formulas for all map units nation-wide. As a result, the calculated soil loss for many Wisconsin fields will now be higher or lower even without changes to field management. Therefore, some fields will require more conservation practices to stay below T, and the reverse will be true for others.

Erosion Sensitivity Factor Change 2012 to 2015

This map shows how the 2015 soil characterization update affects ease of meeting conservation goals. Purple areas show soil map units where more soil conservation practices will need to be implemented to maintain tolerable (T) rates of soil loss. Orange represents soil map units where fewer soil conservation practices may be needed to maintain T. This comparison cannot be made for the areas in brown because the soil map unit names were completely replaced.

Implementation of crop management changes required to meet conservation standards with the new soil characterization updates is not expected overnight. Many farmers will be in the process of implementing new conservation practices over the next 5 years as part of participating in the Farmland Preservation Program. Meeting the new soil conservation requirements that accompany these soil map unit changes will be part of these practices.

\[ ES = K^* LS/T \]

ES = erosion sensitivity
K = soil erodibility factor
LS = length slope factor
T = soil loss tolerance (Tons/acre)

<table>
<thead>
<tr>
<th>ES Values</th>
<th>New Map Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decrease</td>
<td></td>
</tr>
<tr>
<td>No or Minimal Change</td>
<td></td>
</tr>
<tr>
<td>Increase</td>
<td></td>
</tr>
</tbody>
</table>

This map reflects only soils found on cropland.